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This chapter includes:

■ Printer Driver Features on page 1-2
■ Selecting Which Paper to Use on page 1-4
■ Printing Multiple Pages to a Single Sheet (Pages per Sheet) on page 1-5
■ Printing Booklets on page 1-6
■ Printing Separation Pages on page 1-13
■ Printing Cover Pages on page 1-14
■ Scaling on page 1-16
■ Printing Watermarks on page 1-17
■ Printing Negative and Mirror Images on page 1-19
■ Creating and Saving Custom Sizes on page 1-22
■ Printing Special Job Types on page 1-24

See also: 
Using the Windows Printer Driver tutorial at www.xerox.com/office/7760support

Using Printer Driver 
Options

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7760&PgName=qstutorial&FileName=qst_usingdriver.htm&Language=english
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To select booklet printing in a supported driver:

Operating System Steps

Windows 98 SE 
PostScript driver

1. Select the Setup tab.

2. Click the More Layout Options button.

3. Select Print Booklet Style.

4. If desired, specify the creep and gutter.

Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Layout tab.

2. Click the Advanced button.

3. Under Document Options and Printer Features, select On for 
Booklet Layout.

4. If desired, specify the creep and gutter.

5. If desired, specify the paper size from the Target Paper Size 
drop-down list.

Mac OS X (version 10.2 
and higher) driver

1. In the Finishing Options dialog box, select Enable Booklet 
Printing.

2. If desired, specify the creep and gutter.

3. If desired, specify the paper size from the Target Paper Size 
drop-down list.



Using Color Corrections

Phaser® 7760 Color Laser Printer
1-8

Using Color Corrections 
This section includes:

■ More Options for Color Corrections on page 1-9
■ Automatic Color Corrections on page 1-10

The Color Correction options provide simulations of different color devices. Automatic is the 
default correction for general image processing. See the following table to determine what 
option you want to use.

Color Correction Description

Automatic Applies the best color correction to each graphic 
element: text, graphics, and images.

Office Color sRGB Display Approximates the colors on a CRT computer display. 

sRGB Vivid Produces brighter, more saturated colors than sRGB 
Display.

LCD Display Approximates the colors on a LCD computer monitor.

Custom Colors Uses an RGB custom color correction developed for 
your printer using PhaserMatch software.

Press Match SWOP Press Matches Specifications for Web Offset Publications.

Euroscale Matches FOGRA glossy paper specification.

Commercial Approximates U.S. commercial press target.

SNAP Press Matches Specifications for Newsprint Advertising 
Production. 

Japan Color Matches Japan Color 2001 specification.

ISO Coated Matches FOGRA 27L specification.

ISO Uncoated Matches FOGRA 29L specification.

Custom Colors Uses a CMYK custom color correction developed for 
your printer using PhaserMatch software.

None Applies no color correction. Use with other color 
management tools, such as ICC (International Color 

Consortium) profiles, ColorSync, or the PANTONE® 
Color Chart for your printer.

Black and White Converts all colors to black and white or shades of gray.

Use Printer Control 
Panel Setting

Uses the color correction set in the printer. The color 
correction can be set in the printer using either the 
control panel or the CentreWare software (if available).
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To select the color correction in a supported driver:

More Options for Color Corrections
If you need to make additional color adjustments to the color correction you have selected for 
your job, you can adjust the following sliders throughout the More Options selection in a 
supported driver:

■ Lightness: Move the slider to the right to lighten or to the left to darken the colors in your 
print job. (White remains white and black remains black.)

■ Saturation: Move the slider to the right to increase or to the left to decrease the color 
intensity without changing the darkness.

■ Contrast: Move the slider to the right to increase or to the left to decrease the contrast. 
With increased contrast, saturated colors become more saturated, darker colors become 
more black, and lighter colors become more white.

■ Cyan/Red: Move the slider to change the gamma function between cyan and red. Moving 
the slider to the right increases the cyan and decreases the red (its compliment) and vice 
versa.

■ Magenta/Green: Move the slider to change the gamma function between magenta and 
green. Moving the slider to the right increases the magenta and decreases the green (its 
compliment) and vice versa.

■ Yellow/Blue: Move the slider to change the gamma function between yellow and blue. 
Moving the slider to the right increases the yellow and decreases the blue (its compliment) 
and vice versa.

Note: Select the Apply to CMYK check box in the driver to also apply the color adjustments 
when Press Match color corrections are used.

The sample images change as you move the sliders. To track the adjustments, you can select 
the Print Settings on Page box in the driver to have the file name, print-quality mode, and 
color settings of the job printed on the edge of the page.

Operating System Steps

Windows 98 SE, 
Windows 2000, 
Windows XP, or 
Windows Server 2003

1. Select the TekColor tab.

2. Select the desired color correction. Some of the color corrections are 
grouped under Office Color or Press Match.

Mac OS 9.x 1. In the Print dialog box, select General.

2. Select TekColor from the drop-down list.

3. Select the desired color correction for Color.

Mac OS X, version 
10.2 and higher

1. In the Print dialog box, select Image Quality from the drop-down list.

2. Select the desired color correction from the Color Correction drop-
down list.
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To adjust only the current color correction settings for your job through a supported driver:

Automatic Color Corrections
The Automatic color correction selection is designed to apply the best color correction to each 
element (text, graphics, and images). If needed, you can select the color table being used by 
the printer for these elements in your jobs. 

The printer uses the following color tables: 

Note: The Spot Color tab has an option to allow the printer to manage spot colors. This 
option is selected by default; uncheck to disable.

To use the default color table associated with a particular element on the tab, you can select 
Automatic or click the Reset button.

If required in specific circumstances, you can make additional color adjustments to the 
lightness, saturation, contrast, cyan/red gamma function, magenta/green gamma function, and 
yellow/blue gamma function used for a particular element.

Operating System Steps

Windows 2000, 
Windows XP, or 
Windows Server 2003

1. Select the TekColor tab.

2. Select the desired color correction.

3. Click the More Options button to open the Color Adjustment Options 
dialog box.

4. Make the desired adjustments to the sliders for your job.

5. If desired, select Apply to CMYK or Print Settings on Page.

6. Click the OK button to save your changes in the Color Adjustment 
Options dialog box.

Mac OS X, version 
10.2 and higher

1. In the Print dialog box, select Image Quality from the drop-down list.

2. Select the desired color correction.

3. If desired, select Print Settings on Page.

4. Click the More Options button to open the Color Adjustments dialog 
box.

5. Make the desired adjustments to the sliders for your job.

6. If desired, select Apply to CMYK.

7. Click the OK button to save your changes in the Color Adjustments 
dialog box.

Automatic Color Setup Tab Description Default Color Table Used

Office Color Controls the RGB color adjustments. sRGB Display

Press Match Controls the CMYK color adjustments. Commercial Press

Spot Color Controls spot color matching. Spot Color
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To adjust the Automatic color correction in a supported driver:

Operating System Steps

Windows 2000, 
Windows XP, or 
Windows Server 2003

1. Select the TekColor tab.

2. Select the Automatic color correction.

3. Click the Advanced Setup button to open the Automatic Color Setup 
dialog box.

4. On the Office Color, Press Match, and Spot Color tabs of the dialog 
box, make the desired changes to the selections for Text & Graphics 
and Images drop-down lists.

5. If more adjustments are needed for an element, click the More Options 
button, make adjustments to the sliders in the Color Adjustment 
Options dialog box, and then click the OK button.

6. Click the OK button to save your changes in the Automatic Color 
Setup dialog box.

Mac OS X, version 
10.2 and higher

1. In the Print dialog box, select Image Quality from the drop-down list.

2. Select Automatic from the Color Correction drop-down list.

3. Click Automatic Color Setup.

4. On the Office Color, Press Match, and Spot Color tabs, make the 
desired changes to the selections for Text & Graphics and Images 
drop-down lists.

5. If more adjustments are needed for an element, click the More Options 
button after that element, make adjustments to the sliders in the Color 
Adjustments dialog box, and then click the OK button.
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Printing in Black and White
If you want your output in black, white, and shades of gray, you can select Black & White in a 
supported printer driver:  

Selecting Black and White for PCL Drivers

The PCL driver does not contain the black and white color setting. If you are using a PCL 

driver, you need to select Black & White on the control panel:

1. On the control panel, select Printer Setup, and then press the OK button.

2. Select PCL Setup, and then press the OK button.

3. Select Color Mode, and then press the OK button.

4. Select Black & White, and then press the OK button.

Note: Changing the color mode to Black & White on the control panel affects all print jobs. 
Ensure the color mode is set back to color when your print job is finished.

Operating System Steps

Windows 98 SE, 
Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the TekColor tab.

2. Select Black & White.

Mac OS 9 driver 1. In the Print dialog box, select Print Quality/Color 1.

2. Select Black & White from the Color Correction drop-down list.

Mac OS X (version 10.2 
and higher) driver

1. In the Print dialog box, select Image Quality from the drop-down 
list.

2. Select Black and White from the Color Correction drop-down list.
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Printing Separation Pages
A separation page (a divider page or slipsheet) can be inserted after a print job, between 
copies of a print job, or between individual pages of a print job. Specify the tray to use as the 
source for the separation pages.

To specify separation pages in a supported driver:

Operating System Steps

Windows 98 SE, 
Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Output Options tab.

2. Under Separation Pages, select the location of the separation 
pages.

3. Select the tray to use for the separation pages from the Source 
drop-down list.

Mac OS 9 driver 1. In the Print dialog box, select Advanced Options from the 
drop-down list.

2. Select the tray to use for the separation pages from the Separation 
Page Source drop-down list.

3. Select the Separation Page from the drop-down list.

Mac OS X (version 10.2 
and higher) driver

1. In the Print dialog box, select Printer Features from the drop-down 
list.

2. Under Paper Feed Options, select Last Page Paper Source 
drop-down list, and then select the tray to use for the seperation 
pages.
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Printing Cover Pages
A cover page is the first or last page of a document. The printer enables you to choose a 
different paper source for the cover page than for the body of a document. For instance, use 
your company letterhead for the first page of a document, or use card stock for the first and last 
pages of a report.

■ Use any applicable paper tray as the source for printing cover pages.
■ Verify that the cover page is the same size as the paper used for the rest of your document. 

If you specify a different size in the driver than the tray you select as a cover pages source, 
your cover(s) print on the same paper as the rest of your document.

You have several choices for cover pages:

■ None: Prints the first and last pages of your document from the same tray as the rest of 
your document.

■ First: Prints the first page on paper from the specified tray.
■ First and Last: Prints the first and last pages on paper from the specified tray.  

For the back of your front cover to remain blank when 2-sided printing, page two of your 
document must be blank. For the back cover of your document to remain blank, see the 
following table for inserting blank pages. 

Cover Page Print Option Pages Printed on Cover

First 1-sided printing Page 1

2-sided printing Pages 1 and 2

Last 1-sided printing Last page

2-sided printing
(odd-numbered pages)

Last page 

2-sided printing 
(even-numbered pages)

Last two pages 

Print Option Last Page of Text Blank Pages

1-sided printing Add one blank page at the end of the 
document.

2-sided printing Odd-numbered Add two blank pages at the end of the 
document.

Even-numbered Add one blank page at the end of the 
document.
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To select cover pages in a supported driver:

Operating System Steps

Windows 98 SE 
PostScript driver

1. Select the Output Options tab.

2. Under Cover Pages, select First Page Only or First and Last 
Pages.

3. Select the tray to use for the covers from the Source drop-down list.

Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Paper/Quality tab.

2. Under Cover Pages, select First Page Only or First & Last Pages.

3. Select the tray to use for the covers from the Source drop-down list.

Mac OS 9 driver 1. In the Print dialog box, select General.

2. Select First Page From , and then select the tray from the 
drop-down list.

3. Under Print Cover Pages, select Before Document or After 
Document.

4. Under Cover Page Paper Source, select the tray to use for the 
covers from the drop-down list.

Note: For booklet printing, the cover page needs to be selected as the 
Last Page Paper Source.

Mac OS X (version 10.2 
and higher) driver

1. In the Print dialog box, select Paper Feed. 

2. Select First page from, and then select the tray to use for the 
covers.

3. Under Paper Feed Options, select the tray to use for the cover 
pages from the Last Page Paper Source drop-down list.

Note: For booklet printing, the cover page needs to be selected as the 
Last Page Paper Source.
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Scaling
You can reduce or enlarge your page images when they are printed by selecting a scaling value 
between 25 and 400 percent. The default is 100 percent.

To select scaling in a supported driver: 

Operating System Steps

Windows 98 SE 
PostScript driver

1. Select the Setup tab.

2. Click the More Layout Options button.

3. Specify the percentage to scale in the Percentage box.

Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Layout tab.

2. Click the Advanced button.

3. Under Graphic, select the desired percentage for Scaling.

Mac OS 9, Mac OS X 
(version 10.2 and 
higher) driver

1. Select File.

2. Select Page Setup.

3. Specify the percentage in the box for Scale.

50% 100% 200%
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Printing Watermarks
A watermark is additional text that can be printed across one or more pages. For example, 
terms like Draft and Confidential, which you might stamp on a page before distribution, can be 
inserted with a watermark.

In some Windows drivers you can:

■ Create a watermark.
■ Edit an existing watermark’s text, color, location, and angle.
■ Place a watermark on either the first page or every page in a document.
■ Print a watermark in the foreground or background or blend with the the print job.
■ Use a graphic for the watermark.

Note: Not all applications support watermark printing.
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To select, create, and edit watermarks using a supported Windows driver: 

Operating System Steps

Windows 98 SE 
PostScript driver

1. Select the Setup tab.

2. Click the More Layout Options button.

3. Click the Watermark button to display the Watermarks dialog box.

Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Layout tab.

2. Click the Advanced button.

3. Select one of the following options in the Watermarks section under 
Document Options and Printer Features:

■ To use an existing watermark, select it from the Watermarks 
drop-down list. To modify the watermark, click the Edit button to 
display the Watermark Editor dialog box.

■ To create a new watermark, select New, and then click the 
Properties button to display the Watermark Editor dialog box.

4. To print the watermark in the foreground or background or to blend it 
with the job, select the option from the Watermark Options 
drop-down list.

5. To print the watermark on the first page only, select On from the 
First Page Only drop-down list.
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Printing Negative and Mirror Images
You can print pages as a negative image (reverses the light and dark areas in your printed 
image) or mirror image (flips images horizontally on pages when printed).

Note: Negative images are not supported in Windows 2000, Windows XP, and 
Windows Server 2003.

To select negative or mirror images in a supported driver:

Operating System Steps

Windows 98 SE 
PostScript driver 

1. Select the Setup tab.

2. Click the More Layout Options button.

3. Select Print as a Negative Image or Print as a Mirror Image.

Windows 2000, 
Windows XP, Windows 
Server 2003 PostScript 
driver

1. Select the Layout tab.

2. Click the Advanced button.

3. Under Document Options and PostScript Options, select Yes for 
Mirrored Output.

Mac OS 9 driver 1. Select File, select Page Setup, and then select PostScript Options 
from the drop-down list.

2. Select Invert Image (to print a negative image) or Flip Horizontal 
(to print a mirror image).
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Image Smoothing

Image smoothing blends adjacent colors in low-resolution images for smoother color 

transitions. For example, use image smoothing to improve the appearance of a 72 dpi image 
downloaded from the web. Image smoothing is not recommended for images with resolutions 
of 300 dpi or higher.

Print processing is slower when this option is selected.

To select image smoothing in a supported driver:

Operating System Steps

Windows  98 SE 
PostScript driver 

1. Select the Setup tab.

2. Click the More Layout Options button.

3. Select Image Smoothing.

Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Layout tab.

2. Click the Advanced button.

3. Under Document Options and Printer Features, select On for 
Image Smoothing.

Mac OS 9 driver 1. In the Print dialog box, select Print Quality from the drop-down list.

2. In the Print Quality dialog box, select Color 1 from the drop-down 
list.

3. Select On for Image Smoothing.

Mac OS X (version 10.2 
and higher) driver

1. In the Print dialog box, select Image Quality from the drop-down 
list.

2. Select Image Smoothing.
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Black Trapping

Black trapping intelligently spreads color to the black edge areas when combined with colored 

text, graphics, or images. Black trapping is set to ON by default in the driver to ensure the best 
print-quality when black text is printed over a region of color or when colored text is printed 
over a region of black.

To turn black trapping on or off in a supported driver:

Operating System Steps

Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Layout tab.

2. Click the Advanced button.

3. Expand Document Options and Printer Features.

4. Under Black Trapping, select On or Off.

5. Click OK.

Mac OS 9 driver 1. In the Print dialog box, select Print Quality from the drop-down list.

2. In the Print Quality dialog box, select Color 1 from the drop-down 
list.

3. Select ON or OFF for Black Trapping.

Mac OS X (version 10.2 
and higher) driver

1. In the Print dialog box, select Image Quality from the drop-down 
list.

2. Under Black Trapping, select On or Off.
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Creating and Saving Custom Sizes
Phaser 7760 printers can print on custom size paper from Tray 1 (MPT) and Tray 2.You can 
save custom size paper settings in a supported printer driver. Since these custom sizes are 
saved in your computer’s operating system, they are available for you to select in your 
applications.

Note: For details about loading and printing custom size paper, see Printing Basics in the 
User Guide at www.xerox.com/office/7760support.

To create and save a new custom size in a supported driver:

Operating System Steps

Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Paper/Quality tab.

2. Click the My Custom Sizes button.

3. Click the New button.

4. Enter a descriptive name in the Name box.

5. Enter the dimensions in the Width and Height boxes.

6. Click the Save button.

Mac OS X 10.4 1. Select Page Setup from the File Menu.

2. Select the Phaser 7760 printer.

3. In the Paper Size drop-down list select Manage Custom Sizes.

4. Click the + button to add a new custom page size.

5. Provide a descriptive name for the custom page size and enter the 
page size and margin information.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7760&PgName=tech&Language=english
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Job Completion Notification
You can select Notify Me When My Job Completes if you want to be notified when your job is 
done printing. A message appears in the lower-right corner of your computer screen with the 
name of the job and the name of the printer where it was printed.

Note: This feature is only available when your printer is connected to your computer over a 
network.

To select job notification in a supported driver:

Operating System Steps

Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Output Options tab.

2. Check the Notify Me When My Job Completes box.

3. Click OK.

Mac OS X (version 10.2 
and higher) driver

1. Select the Troubleshooting pane.

2. Check the Notify Me When My Job Completes box.
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Printing Special Job Types
This section includes:

■ Sending Personal, Personal Saved, Secure, Proof, or Saved Print Jobs on page 1-25
■ Sending Print With Jobs on page 1-26
■ Printing or Deleting Secure Print Jobs on page 1-27
■ Printing or Deleting Personal Print Jobs on page 1-27
■ Printing or Deleting Proof and Saved Print Jobs on page 1-27
■ Printing or Deleting Personal Saved Jobs on page 1-28

Select one of the following special job types:

■ Normal: Prints the job without requiring a password.
■ Personal Print: Prints the job when you select your user name on the control panel or in 

CentreWare IS.
■ Personal Saved Print: Stores the job on the hard drive whith your numeric password so 

you can print it on demand from the control panel or from CentreWare IS. The job is not 
deleted after printing.

■ Secure Print: Prints the job only after you enter the four-digit numeric password on the 
control panel.

■ Proof Print: Prints only one copy of the job so that you can proof the copy. If you want to 
print the remaining copies, select the job name on the control panel.

■ Saved Print: Stores the job on the hard drive so you can print it on demand from the 
control panel. The job is not deleted after printing. This is useful for any document you 
frequently print, such as tax forms, personnel forms, or requisition forms.

■ Print With: Prints the current job with existing jobs that are stored on the printer’s hard 
drive that you specifiy in the Print-With Settings dialog box when you click the 
Print With button.

Note: Protected Jobs are another special job type. These are jobs that have been copied or 
moved from the Public Jobs group in CentreWare IS. For more information, click the 
Help button in CentreWare IS to view the online help.
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Sending Personal, Personal Saved, Secure, Proof, or Saved 
Print Jobs 
Use a supported driver to specify a job as a personal, personal saved, secure, proof, or saved 
print job.

Note: Personal and Personal Saved print jobs are not supported in Windows 98 SE.

Operating System Steps

Windows 98 SE, 
Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Output Options tab.

2. Select the job type under Walk-Up Features.

■ For a secure job, enter a four-digit password to assign to this job. 

■ For a proof print or saved print job, enter the name you want to give 
this job.

■ For a personal saved job, enter a four-digit password to assign to this 
job and enter the name you want to give this job.

Mac OS 9 driver In the Print dialog box, select the job type from the Job Type drop-down 
list.

■ For a secure print or personal saved job, enter a four-digit password 
to assign to this job.

Mac OS X (version 
10.2 and higher) driver

In the Print dialog box, select the job type from the Job Types 
drop-down list.

■ For a secure print or personal saved job, enter a four digit number, 
ranging from 0000 through 9999, in the Numeric Password field.

■ For a proof print or saved print job, enter a document name (up to 20 
alpha characters) in the Document Name field.
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Sending Print With Jobs 
To select jobs to send with your current job in a supported driver:

Note: Print With jobs are not available for AppleTalk or USB connected printers.

Operating System Steps

Windows 98 SE, 
Windows 2000, 
Windows XP, 
Windows Server 2003 
PostScript driver

1. Select the Output Options tab.

2. Select Print With under Walk-Up Features.

3. Enter a four-digit password to assign to this job. 

4. Click the Print With button to display the Print With Settings dialog 
box.

5. Select a personal saved or shared saved job from the list on the left 
to be printed with the current job, and then click the Move Right 
button.

6. To change the order of the jobs to be printed, select a job to be 
moved in the list on the right, and then click the Move Up or Move 
Down button.

Mac OS X (version 
10.2 and higher) driver

1. In the Print dialog box, select Print With from the Job Types 
drop-down list.

2. Enter a four digit number, ranging from 0000 through 9999, in the 
Numeric Password field and click the Set button.

3. Select a personal saved or shared saved job from the list on the left 
to be printed with the current job, and then click the Move Right 
button.

4. To change the order of the jobs to be printed, select a job to be 
moved in the list on the right, and then click the Move Up or Move 
Down button.
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Printing or Deleting Secure Print Jobs
To print or delete a secure print job, specify the four-digit password on the control panel:

1. Select Walk-Up Features, and then press the OK button.

2. Select Secure Print Jobs, and then press the OK button.

3. Scroll to your User Name, and then press the OK button.

4. Scroll to the correct number for the first digit of the numeric password, and then press the 
OK button to accept that digit.

5. Repeat Step 4 for the second, third, and fourth digits.

Note: If you enter less than four digits in the driver’s Password field, enter zeros before 
your password so that there are four digits displayed on the control panel. For example, if 
you entered 222 in the driver, enter 0222 on the control panel. Use the Back button to 
return to a previous digit.

6. If you submitted more than one secure print job with that password, select the desired job 
or select All of Them, and then press the OK button.

7. Select Print and Delete or Delete, and then press the OK button to print or delete the job.

Printing or Deleting Personal Print Jobs 
To print or delete a personal print job, select your user name on the control panel:

1. Select Walk-Up Features, and then press the OK button.

2. Select Personal Print Jobs, and then press the OK button.

3. Select your User Name, and then press the OK button.

4. Select Print and Delete or Delete, and then press the OK button to print or delete all of 
your personal print jobs.

Printing or Deleting Proof and Saved Print Jobs
To print a saved print job, print the remaining copies of a proof print job, or delete a saved or 
proof print job, select the job name on the control panel:

1. Select Walk-Up Features, and then press the OK button.

2. Select Proof Print Jobs or Saved Print Jobs, and then press the OK button.

3. Select your job name, and then press the OK button. 

4. Select Print and Delete (for proof prints), Print and Save (for saved prints), or Delete, 
and then press the OK button.

5. If you are printing, scroll to the desired number of copies, and then press the OK button to 
print the job.



Printing Special Job Types

Phaser® 7760 Color Laser Printer
1-28

Printing or Deleting Personal Saved Jobs
To print or delete a personal saved print job, select the job name on the control panel:

1. Select Walk-Up Features, and then press the OK button.

2. Select Personal Saved Jobs, and then press the OK button.

3. Select your job name, and then press the OK button. 

4. Scroll to the correct number for the first digit of the numeric password, and then press the 
OK button to accept that digit.

5. Repeat Step 4 for the second, third, and fourth digits.

Note: If you enter less than four digits in the driver’s Password field, enter zeros before 
your password so that there are four digits displayed on the control panel. For example, if 
you entered 222 in the driver, enter 0222 on the control panel. Use the Back button to 
return to a previous digit.

6. If you submitted more than one personal saved job with that password, select the desired 
job or select All of Them, and then press the OK button.

7. Select Print and Delete or Delete, and then press the OK button to print or delete the job.
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This chapter includes:

■ Types of Fonts on page 2-2
■ Viewing a List of Resident Fonts on page 2-2
■ Printing Font Samples on page 2-3
■ Downloading Fonts Using the CentreWare Font Management Utility on page 2-5

Using Fonts
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Types of Fonts
Your printer uses the following types of fonts:

■ Resident fonts
■ Fonts downloaded into printer memory
■ Fonts downloaded with your print job from the application

Adobe Type Manager (ATM) software enables your computer to display these fonts on your 
computer screen as they will appear in your prints. 

If you do not have ATM on your computer:

1. Install it from the Software and Documentation CD-ROM.

2. Install the printer’s screen fonts for your computer from the ATM folder. 

Note: ATM is not supported on Windows 64-bit systems.

Viewing a List of Resident Fonts

To view a list of resident PCL or PostScript fonts, use CentreWare IS:

1. Launch your web browser.

2. Enter your printer’s IP address in the browser’s Address field (http://xxx.xxx.xxx.xxx).

3. Click Properties.

4. Select the Emulations folder on the left sidebar.

5. Select Font Files.

6. Select either PostScript or PCL.



Printing Font Samples

Phaser® 7760 Color Laser Printer
2-3

Printing Font Samples
This section includes:

■ Using the Control Panel on page 2-3
■ Using CentreWare IS on page 2-3
■ Using a Windows Printer Driver on page 2-4

Use one of the following options to print a list of available PostScript or PCL fonts:

■ The printer’s control panel
■ CentreWare IS
■ The printer driver

Using the Control Panel
To print either a PostScript or PCL font list on the control panel:

1. Select Information, and then press the OK button. 

2. Select Information Pages, and then press the OK button.

3. Select either PCL Font List or PostScript Font List, and then press the OK button to 
print.

Using CentreWare IS
To print either a PostScript or PCL font list from CentreWare IS:

1. Launch your web browser.

2. Enter your printer’s IP address in the browser’s Address field (http://xxx.xxx.xxx.xxx).

3. Click Properties.

4. Select the Emulations folder on the left sidebar.

5. Select Font Files.

6. Select either PostScript or PCL.

7. Print the list of fonts from your browser.
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Using a Windows Printer Driver

To print either a PostScript or PCL font list from your printer driver:

1. Select Start, select Settings, and then select Printers.

2. Right-click the Phaser 7760 Color Laser Printer, and then select Properties.

3. Select the Troubleshooting tab.

4. In the Printer Information Pages drop-down list, select PostScript Font List or PCL 
Font List.

5. Click the Print button.
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Downloading Fonts Using the CentreWare Font 
Management Utility
To supplement the resident fonts (which are always available for printing), you can download 
fonts from your computer to the printer’s memory or to the printer’s hard drive. Downloading 
fonts to a printer can improve printing performance and reduce network traffic.

You can list, print, and download PostScript, PCL, and TrueType fonts to your printer using 
the CentreWare Font Management Utility. This utility helps you manage fonts, macros, and 
forms on a printer’s hard drive.

To download and install the Font Management Utility on Windows operating systems:

1. Go to www.xerox.com/office/pmtools.

2. Select your printer from the Select Product drop-down list.

3. Click Additional Utilities in the Printer Utilities table.

4. Select your operating system.

5. Locate the CentreWare Font Management Utility option, and do one of the following:

■ Windows: Save the .exe file to your computer.
■ Macintosh: Select Start to download the .hqx file.

6. Install the font manager.

Note: If you turn off the printer, the fonts you download to memory are deleted. You must 
download them again when you turn on the printer. Fonts downloaded to the hard drive are not 
deleted when you turn off the printer.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=pmtools&Language=english
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This chapter includes:

■ Printer Management Software on page 3-2
■ Windows 2000, Windows XP, and Windows Server 2003 on page 3-4
■ Windows 98 SE on page 3-11
■ Macintosh on page 3-15
■ Novell on page 3-21
■ UNIX (Linux) on page 3-22

This chapter provides detailed information for the system administrator. Additional 
information about print quality, maintenance, and troubleshooting issues is located in the 
User Guide.

See also: 
User Guide at www.xerox.com/office/7760support

Networking

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7760&PgName=tech&Language=english
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Printer Management Software
This section includes:

■ CentreWare Internet Services (IS) on page 3-2
■ CentreWare Web on page 3-3

CentreWare Internet Services (IS)
CentreWare IS provides a simple interface that enables you to manage, configure, and monitor 
networked printers from your desktop using an embedded web server. CentreWare IS gives 
administrators easy access to printer status, configuration, and diagnostic functions. It also 
provides users with access to printer status and special printing functions such as printing 
saved jobs. With CentreWare IS software, you can access and manage your printers over a 
TCP/IP network using a web browser. 

CentreWare IS enables you to:

■ Check supplies status from your desktop, saving a trip to the printer. Access job 
accounting records to allocate printing costs and plan supplies purchases.

■ Define a network printer search and view a list of printers using Printer Neighborhood. 
The list provides current status information and allows you to manage printers 
independent of network servers and operating systems. 

■ Configure printers from your desktop. CentreWare IS makes it easy to copy settings from 
one printer to another. 

■ Set up and use a simple web-browser-based printing system. Marketing collateral, sales 
materials, business forms, or other standardized, frequently used documents can be saved 
as a group with their original driver settings then reprinted on demand at high speed from 
any user's browser. A printer with a hard drive is required to support these functions. In 
some printer models, a DX configuration is required to support these functions.

■ Troubleshoot print-quality problems using built-in diagnostics. 
■ Define a link to your local web server’s support page.
■ Access online manuals and technical support information located on the Xerox website.

Note: CentreWare IS requires a web browser and a TCP/IP connection between the printer 
and the network (in Windows, Macintosh, or UNIX environments). TCP/IP and HTTP must be 
enabled in the printer. JavaScript is required to access the pages in Printer Neighborhood. If 
JavaScript is disabled, a warning message appears and the pages do not function properly.

For complete informaton about CentreWare IS, click the Help button in CentreWare IS to go 
to the CentreWare IS Online Help.

See also: 
Using CentreWare Internet Services tutorial at www.xerox.com/office/7760support

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7760&PgName=qstutorial&FileName=qst_usingcwis.htm&Language=english


Printer Management Software

Phaser® 7760 Color Laser Printer
3-3

CentreWare Web
CentreWare Web is a multi-vendor printer management, installation, and troubleshooting 
application. Use CentreWare Web to remotely manage, install, and troubleshoot printers on 
your network using a web browser. Printers are found through network or print server 
discovery and managed over TCP/IP networks using RFC-1759 SNMP (Simple Network 
Management Protocol).

With CentreWare Web you can:

■ Remotely add ports, queues, and drivers to Windows 2000, Windows XP, and 
Windows Server 2003.

■ Install, troubleshoot, upgrade, and clone wizards to aid all users in performing 
administrative tasks.

■ Install CentreWare Web on a server for availability to all clients on the network with 
Internet access.

■ Support multiple users and provide different levels of user access privileges for 
administrators or guests.

■ Discover printers on local and remote subnets.
■ Automatically discover printers as scheduled.
■ Generate reports.
■ Connect to printer web servers for additional printer-specific features, including help.

For more information, go to www.xerox.com/office/pmtools, and select your specific printer 
model to view the CentreWare Web User Guide.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=pmtools&Language=english
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Windows 2000, Windows XP, and Windows Server 
2003
This section includes:

■ Preliminary Steps on page 3-4
■ Quick CD-ROM Install Steps on page 3-4
■ Other Methods of Installation on page 3-5
■ Windows 2000, Windows XP, and Windows Server 2003 Troubleshooting on page 3-9

Preliminary Steps
These preliminary steps must be performed for all printers:

1. Verify that the printer is plugged in, turned On, and connected to an active network.

2. Verify that the printer is receiving network information by monitoring the LEDs on the 
back of the printer or on the CentreDirect External Print Server. When the printer is 
connected to a functioning network and receiving traffic, its link LED is green, and its 
amber traffic LED is flashing rapidly.

3. Proceed to Quick CD-ROM Install Steps or Other Methods of Installation for the 
installation method desired.

4. Print the Configuration page and keep it for reference.

Quick CD-ROM Install Steps
To install the printer driver:

1. Insert the Software and Documentation CD-ROM into the computer’s CD-ROM drive. If 
the installer does not launch, do the following:

a. Click Start, and then click Run.
b. In the Run window, type: <CD drive>:\INSTALL.EXE.

2. Select your desired language from the list.

3. Select Install Printer Driver.

4. Click I Agree to accept the Xerox Software License Agreement. 

5. In the Select Printer dialog box, the default Use Walk-Up Technology (recommended 
for network printers) is selected. Click Next.

6. Follow the Use Walk-Up Technology instructions displayed.

7. Click Exit Program.

Note: If the Walk-Up Technology dialog box remains onscreen after you have completed 
Steps 1–6, click the Cancel button, and then click Select from the following discovered 
printers. Follow the onscreen prompts to complete the installation procedure.
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Other Methods of Installation
Your printer can also be installed on a Windows 2000, Windows XP, or Windows Server 2003 
network using one of these methods:

■ Microsoft TCP/IP Protocol
■ Microsoft IPP Port

To monitor or configure your printer, use CentreWare IS with a web browser if your printer is 
connected to a Windows 2000, Windows XP, or a Windows Server 2003 network with the 
TCP/IP protocol enabled.

Note: The CentreWare methods are not discussed in this section. 

See also: 
Printer Management Software on page 3-2 (CentreWare IS)

Microsoft TCP/IP Protocol

Note: For Windows XP, select Classic Look or the Windows XP procedures will not match 
the steps below. To select Classic Look, click Start, click Settings, and then click Taskbar 
and Start Menu. Select the Start Menu tab, and then select the Classic Start menu. Click 
OK. 

To verify that TCP/IP is installed:

1. Right-click the My Network Places icon on the desktop, and then click Properties.

2. Right-click Local Area Connection, and then click Properties.

3. Click the General tab to verify that Internet Protocol (TCP/IP) is installed.

■ If the Internet Protocol (TCP/IP) box is checked, the software is installed.
■ If the Internet Protocol (TCP/IP) box is not checked, the software is not installed. 

Install TCP/IP software using the documentation provided by Microsoft, and then 
return to this document.

Adding the Printer

To add the printer:

1. On the desktop click Start, and then click Settings.

2. Select one of these options:

■ Windows 2000: Click Printers, double-click Add Printer to launch the Add Printer 
Wizard, and then click Next. 

■ Windows XP or Windows Server 2003: Click Printers and Faxes. Double-click 
Add Printer to launch the Add Printer Wizard, and then click Next. 

3. Click the Local Printer button, and then click Next.

4. Click the Create a New Port button.

5. Select Standard TCP/IP Port from the New Port Type drop-down menu, and then click 
Next.
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6. Click Next.

7. Enter the IP Address of the printer you want to use in the Printer Name or IP Address 
edit box. Click Next.

8. Select one of these options:

■ Click Finish in the Confirmation window if the data is correct.
■ Click the Back button to correct the data if it is incorrect, and then click Finish in the 

Confirmation window.

Configuring the Printer

To configure the printer:

1. Insert the Software and Documentation CD-ROM into the computer’s CD-ROM drive and 
click Have Disk.

2. Click the Browse button, and then select the directory which contains the Windows 2000 
or Windows XP drivers.

3. Select the *.INF file, and then click Open. 

4. Verify that the path and filename are correct, and then click OK. 

5. Enter a name for the printer and select whether you want that printer to be the default. 
Click Next.

6. Select one of these options:

■ If the printer is not shared, click Next.
■ If the printer is shared, enter a Share Name, check the Share box, and then click 

Next.

Printing a Test Page

You are prompted to print a test page.

1. Select one of these options:

■ Click Yes to print a test page, and then click Next.
■ Click No if you do not want to print a test page, and then click Next.

2. Select one of these options in the Completing the Add Printer Wizard screen: 

■ Click the Finish button if the data presented is correct. Proceed to Step 3.
■ Click the Back button to correct the data if incorrect, and then click Finish in the Add 

Printer Wizard when the data is correct. Proceed to Step 3.

3. If you printed a test page, you are prompted to confirm that the test page printed:

■ Click Yes if the test page printed successfully.
■ Click No if the test page did not print or printed incorrectly.

See also: 
Windows 2000, Windows XP, and Windows Server 2003 Troubleshooting on page 3-9
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Microsoft IPP Port
Follow these steps to obtain the printer’s URL and create an Internet Printing Protocol (IPP) 
printer.

Obtaining the Printer’s URL (Network Path) 

To obtain the printer’s URL:

1. Launch your web browser.

2. Enter your printer's IP address in the browser’s Address field (http://xxx.xxx.xxx.xxx). 

3. Select Properties.

4. Select the Protocols folder on the left sidebar.

5. Select IPP. The Network Path field on the IPP Settings page displays the printer’s URL.

Creating an IPP Printer

To create an IPP printer:

1. On the desktop, click Start, click Settings, and then click Printers.

2. Double-click Add Printer to launch the Microsoft Add Printer Wizard. 

3. Select Network Printer, and then click Next.

4. When prompted for Network Path (Windows 9x) or URL (Windows NT, Windows 2000, 
Windows XP), enter the printer’s URL in the following format:

http://printer-ip-address/ipp

Note: Substitute your printer’s IP address or DNS name for printer-ip-address.

5. Click Next.

Configuring the Printer

To configure the printer:

1. Insert the Software and Documentation CD-ROM into the computer’s CD-ROM drive and 
click Have Disk.

2. Click the Browse button, and then select the directory which contains the Windows 2000 
or Windows XP drivers.

3. Select the *.INF file, and then click Open. 

4. Verify that the path and filename are correct, and then click OK. 

5. Enter a name for the printer and select whether you want that printer to be the default. 
Click Next.

6. Select one of these options:

■ If the printer is not shared, click Next.
■ If the printer is shared, enter a Share Name, check the Share box, and then click 

Next.

7. Click Next.
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Windows XP and Windows Server 2003 64-Bit Server to 
32-Bit Client Installation
To install from a 64-Bit Server:

1. Locate and install the 64-bit Windows driver from the Software and Documentation 
CD-ROM.

2. Right-click on My Computer, and then select Manage.

3. Expand Local Users and Groups, and then double-click the Groups folder.

4. Double-click on Administrators, and then click the Add button.

5. Type the 32-bit client’s login name, and then click OK.

To install from a 32-Bit Client:

1. Insert the Software and Documentation CD-ROM and close the installer window.

2. Open My Network Places, and then browse to the 64-bit system.

3. Double-click on Printers and Faxes.

4. Select File, and then select Server Properties from the drop-down list.

5. On the Drivers tab, click the Add button.

6. Click Next, select Have Disk, and then click OK.

7. Browse to the 32-bit driver on the Software and Documentation CD-ROM, and open the 
Windows folder.

8. Open the appropriate language folder, select the .inf file, and then click OK.

9. Choose your Printer, and then click Next.

10. Select Intel Box for Windows XP, and then click Next.

11. Click Finish.

12. In the My Network Places dialog box, double-click the 64-bit system, and then select 
Yes.
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Windows 2000, Windows XP, and Windows Server 2003 
Troubleshooting

Note: For Windows XP, select Classic Look or the Windows XP procedures will not match 
the steps below. To select Classic Look, click Start, click Settings, and then Taskbar and 
Start Menu. Select the Start Menu tab, and then select Classic Start menu. Click OK. 

This Troubleshooting section assumes you have completed the following tasks:

■ Loaded a Phaser printer PCL or PostScript printer driver.
■ Printed and kept a current copy of the Configuration page.

Verifying Settings
To verify settings:

1. Verify the settings on the Configuration page.

■ IP Address Source is set to: DHCP, Control Panel, BOOTP, or Auto IP (depending 
on your network configuration).

■ Current IP Address is set correctly. (Note this address if it is assigned by Auto IP, 
DHCP, or BOOTP.)

■ Subnet Mask is set correctly (if used).
■ Default Gateway is set correctly (if used).
■ LPR is enabled. Verify that the LPR and AppSocket settings are set as desired.
■ Interpreters: Auto, PCL, or PostScript (depending on your driver).

2. Verify that the client is logged into the network and printing to the correct print queue. The 
user should also have access to the Phaser printer queue.

Verifying Driver Installation
To verify driver installation:

1. Right-click My Network Places on the desktop, and then click Properties. 

2. Right-click Local Area Connection, and then click Properties. 

3. Select the General tab. View the list of installed network protocols to verify that TCP/IP is 
installed. (For more information, contact your network administrator.)

4. Click Install to install any components not listed, and then restart your computer.

5. Click Start, click Settings, and then click Printers. 

6. Right-click the printer icon, and then click Properties.

7. Select the Advanced tab. Verify that the correct printer driver is installed.

8. Select the Ports tab. Verify that the IP Address in the Print to the Following Ports list is 
identical to the one on the Configuration page. You may need to click the 
Configure Port button to see the IP address. If necessary, re-select the TCP/IP number 
used for the printer.
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Printing a Test Page
To print a test page:

1. Select the General tab.

2. Click Print Test Page. If the printer does not print, select PhaserSMART Technical 
Support on the Troubleshooting tab of your Windows printer driver to access 
PhaserSMART Technical Support.

See also: 
www.xerox.com/office/7760support

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7760&PgName=tech&Language=english
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Windows 98 SE 
This section includes:

■ Preliminary Steps on page 3-11
■ Quick CD-ROM Install Steps on page 3-12
■ Other Methods of Installation on page 3-12
■ Windows 98 SE Troubleshooting on page 3-14

Preliminary Steps
Follow these preliminary steps:

1. Verify that the printer is plugged in, turned on, and connected to an active network.

2. Verify that the printer is receiving network information by monitoring the LEDs on the 
back of the device or on the CentreDirect External Print Server. When the printer is 
connected to a functioning network and receiving traffic, its link LED is green, and its 
amber traffic LED is flashing rapidly.

3. Print a Configuration page and verify that the desired protocol is enabled, and then follow 
one of these options:

■ Proceed to Step 4 if you do not have a TCP/IP address configured for your printer. 
■ Proceed to Step 5 if you do have a TCP/IP address configured for your printer.

4. Do one of the following if you do not have a TCP/IP address configured for your 
computer:

■ Contact your system administrator to ensure that configuration is made according to 
your company guidelines. 

■ Configure your PC with a unique address such as 192.1.1.1. 

5. If you have a TCP/IP address, follow these steps to verify the IP address for your PC:

a. Click Start, and then click Run.
b. Enter winipcfg in the Open field. (If the file is not found, TCP/IP may not be 

installed.)
c. Click OK.
d. Select your network adapter from the list. The IP address is listed in the IP Address 

field.

Note: For more information about installing and configuring TCP/IP in Windows 
environments, go to your Microsoft Windows documentation.

6. Proceed to Quick CD-ROM Install Steps or Other Methods of Installation for the 
installation method desired.

See also: 
Quick CD-ROM Install Steps on page 3-12
Other Methods of Installation on page 3-12
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Quick CD-ROM Install Steps
To use quick CD-ROM installation:

1. Insert the Software and Documentation CD-ROM into the computer’s CD-ROM drive. If 
the installer does not launch, do the following:

a. Click Start, and then click Run.
b. In the Run window, type: <CD drive>:\INSTALL.EXE.

2. Select your desired language from the list.

3. Select Install Printer Driver.

4. Click I Agree to accept the Xerox Software License Agreement. 

5. In the Select Printer dialog box, the default Use Walk-Up Technology (recommended 
for network printers) is selected. Click Next.

6. Follow the Use Walk-Up Technology instructions displayed.

7. Click Exit Program.

Note: If the Walk-Up Technology dialog box remains onscreen after you have completed 
Steps 1–6, click the Cancel button, and then click Select from the following discovered 
printers. Follow the onscreen prompts to complete the installation procedure.

See also: 
Knowledge Base at www.xerox.com/office/7760support

Other Methods of Installation
Install your printer on a Windows 98 SE network using PhaserPort software.

PhaserPort Software
The Windows installer installs PhaserPort for Windows (for those installations using 
PostScript drivers). PhaserPort for Windows is a Xerox print monitor for printing over 
Windows 98 SE TCP/IP peer-to-peer networks. PhaserPort can be used to add or remove TCP/
IP ports.

Note: PhaserPort is the preferred utility for PostScript installations.

Adding a Port

To add a printer port:

1. Open Printer Properties for the printer you would like to attach to the new TCP/IP port.

2. Click Start, click Settings, and then click Printers.

3. Right-click the printer to be attached to the new TCP/IP port, and then click Properties.

4. Click the Details tab, and then click the Add Port button.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7760&PgName=tech&Language=english
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5. Select Other.

6. From the list of available printer-port monitors, select PhaserPort, and then click OK.

Configuring a Port 

PhaserPort enables you to:

■ Choose a name for the new port.
■ Identify a printer by its DNS Name or IP Address.

To install a port using PhaserPort:

1. In the Add PhaserPort window:

■ Enter a unique name for the port being added in the Description section.
■ Enter the printer host name or IP Address in the DNS/Address section.

2. Click OK.

Changing a PhaserPort IP Address

If the printer’s IP address is changed, you must change the IP address for the device’s 
corresponding port:

1. Click Start, click Settings, and then click Printers.

2. Right-click the printer to be changed to a new PhaserPort IP address, and then click 
Properties.

3. Select the Details tab. 

4. Verify that PhaserPort appears in the Print to the Following Port field.

5. Click Port Settings. The Configure PhaserPort dialog box appears.

6. Do one of the following:

a. If you know the correct IP address or DNS name for the printer, enter that information.
b. If you don’t know the printer’s IP address or DNS name, click Browse to display a list 

of printers on the network. 
c. Double-click the appropriate printer. PhaserPort automatically enters the information 

into the Configure PhaserPort dialog box. 

Note: To search the network again, click Refresh. To expand the search to other subnets, 
click Advanced. 

7. Click OK.

8. Click OK again to apply the changes.
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printer driver
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listed by operating system, 1-2
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Macintosh, 3-15
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Windows Server 2003, 3-9
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job timing, 4-21
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personal saved jobs, 1-28
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saved print jobs, 1-27
secure print jobs, 1-27
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Windows Server 2003, 3-6, 3-10

usage profile reports, 4-21
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proof print jobs, 1-2, 1-24
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printing, 1-27
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Q
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saved print jobs, 1-2, 1-24
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printing, 1-27
sending, 1-25

saving energy
power saver timeout, 4-6
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secure print jobs, 1-2, 1-24
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printing, 1-27
sending, 1-25
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PhaserPort software
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printer management, 3-2
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